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1 WHAT IS ENDNOTE (21)? 

EndNote is a software package that acts as a database manager for references and can produce 

references and a bibliograpy. Such programs make collecting, storing, managing and using 

bibliographic data much easier and clearer. They are commonly called reference managers. Zotero and 

Mendeley are other examples of reference managers. 

 

The big advantage of using reference managers is saving time because have your own database 

(library) of consulted literature, which you can easily search. Moreover, when writing academic texts, 

references and bibliography are automatically displayed in the correct citation style. 

 

With EndNote it is possible to: 

− enter literature references yourself into a personal library or import them automatically from 

databases such as Jurisquare, Strada lex, HeinOnline, Web of Science, Google Scholar, Lib.ugent 

(the university library's online catalog), Biblio, ..., 

− searching databases, allowing you to directly import references into EndNote 

− edit and search reference data, 

− insert citations in texts and format them in the desired bibliographic style such as APA, Chicago, 

Harvard, ... or in journal–specific bibliographic styles (European Law Journal, International Review 

of Law and Economics, British Journal of Criminology, etc...), 

− use templates in Word for the formatting of manuscripts according to the publication styles of for 

example APA or specific scientific journals 

− import pdf files and link these to references in Zotero, 

− compose ordered bibliographies (e.g., by subject) and group references within a database using 

smart or custom gropus, 

− look up the full text of an article. 

 

Through Athena you always have access to the most recent version (currently 21).    
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2 USING ATHENA 

Ghent University has an institutional license to EndNote. The program can be used by all students and 

staff of the university.  

 

EndNote is available through Athena (apps/categories/office). Learn more about Athena at the 

helpdesk.  

 

Working through Athena offers the advantage that no software needs to be installed on your own PC, 

errors in the software are quickly corrected, new bibliographic styles are automatically loaded, and the 

most recent version is always available. Moreover, the IT department can also help you more easily 

should problems arise.  

 

To make optimal use of the program's functionality (cite-while-you-write, references, direct import from 

databases) it is important to always use Athena. 

 

   

https://helpdesk.ugent.be/athena/en/index.php
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3 SETTING UP AND USING YOUR ENDNOTE (21) 

LIBRARY  

3.1 Home screen 

 

 

 

 

Groups 

In this panel you can easily navigate between the full reference list, parts of that list (groups and group 

sets) and online searches.  

 

Reference list 

Here you see the overview of the entire database or the selected group of references. For each 

reference a number of fields are shown. The list is easy to sort by clicking in the header of a column. 

 

Through ‘Edit’ – ‘Preferences’, it is possible to show other fields and change their order. 

 

The search bar at the top allows you to search within your own library or (a number of) external 

databases.  

 

Reference 

Within the ‘Summary’ tab you can see the currently selected reference. The ‘Edit’ tab allows you to 

quickly make changes to references. In the ‘PDF’ tab you can attach a pdf to the reference and view it 

once it has been attached.    

Reference Reference list Groups 
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3.2 Creating a library 

A new database or library can be created by choosing 'File' - 'New'. The 'File Name' can contain spaces 

and be up to 255 characters. 

 

Save the files on your H-drive (this is the part of the server space that Ghent University puts at your 

disposal). This way you always have access to your data (via Athena), regardless of the computer you 

are working on. 

 

A database consists of two parts: a file with the .enl extension and a directory with the .data extension. 

Both components are necessary to ensure proper operation of the database. 

 

Creating one large database is recommended. By efficiently using keywords and groups, data can be 

easily organized and retrieved. 

 

3.2.1 Entering data 

3.2.1.1 Manually  

 

− Click ‘References’ > ‘New Reference’, the button, or ctrl/command-N. 

− First select the correct ‘Reference Type’ (e.g. ‘Journal Article’ for a contribution in a journal). 

− For journal articles, the first 7 fields (author, year, title, journal title, volume and number) are required 

to be filled in to create a complete reference. The additional fields are not mandatory, but very useful 

to complete the data. 

− Author names can be entered in two ways: first name last name (without punctuation) or last name, 

first name (with comma). The second way is recommended so that conflicts do not arise when there 

are multiple first names or when the surname consists of more than one word. Thus, ‘Vander Beken, 

Tom’ or ‘Bassiouni, Mahmoud Cherif’. Sometimes the author of a publication is not a person but an 

organization. For EndNote to recognize this, the name of the organization must be given and ended 

with a comma. Thus: 'European Council on Refugees and Exiles,'. If there is a comma in the name 

of the organization, use two commas for this (e.g., 'Center for Migration,, Policy and Society,'). 

− If there is more than one author, organization or editor, the different names should be listed 

underneath each other. You can separate these by pressing the 'enter' key after each name. 

− When entering indexed fields (author, journal title and keywords), data are automatically populated 

using previously entered references; new data appear in red. Again, the field separator is 'enter'.  

− Fill in the data without additional formatting (not bold, italic,...), because the final formatting will be 

determined by the chosen output style. 
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− There is an option to enter a URL that links to the article, or to attach a pdf file. A URL can be added 

in the corresponding field, a pdf file can be added via the 'PDF' tab (to the right of 'Edit'). 

 

3.2.1.2 Importing pdf files 

EndNote provides the option to import a pdf file, immediately adding both the reference and the file 

itself to your library. This is only possible for pdfs with metadata (e.g. from full text academic databases). 

They can be imported in the following way:  

− Save or download the desired article in pdf format. 

− In EndNote, go to ‘File’ – ‘Import’ – ‘File’. 

− Select the correct file, choose ‘PDF’ for the import option and click on ‘Import’.  

 

 

 

This will create a new reference based on the metadata included in the pdf. To ensure that information 

was added correctly, you can check the reference panel and edit information if necessary.  

You can also import an entire folder of pdf files through ‘File’ – ‘Import’ – ‘Folder’. EndNote will then 

create a reference for every pdf file in that folder. 

 

3.2.1.3 Direct import from databases 

For a number of databases, it is possible to import references directly into your EndNote library. 

Important here is that you should use a web browser (Google Chrome, Firefox, ...) on Athena. If you 

use the local browser the link to your EndNote library will not be made. Regarding the direct import of 

references from the Belgian legal databases (Jura, Strada lex, Jurisquare), this function is only available 

in Jurisquare and Strada lex. After importing the references into EndNote, be sure to check that the 

work was done correctly and that all information was filled in correctly. 

 

Web of Science 

− Open your browser in Athena  

− Go to Web of Science (via the catalog lib.ugent.be or directly via www.webofknowledge.com) 

− Perform a search 

− Check the desired documents or click on the article that interests you 

− Click on ‘export’ – ‘RIS (other reference software)’ 

− Select ‘Record Content: Full Record’ in the pop–up that appears and click on ‘export’. The document 

will now be downloaded. By clicking on the file, you will open the reference in EndNote. 

http://www.webofknowledge.com/
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Strada lex 

− Open your browser in Athena 

− Go to Strada lex (directly from stradalex.com or from lib.ugent.be) 

− Perform a search and click on the title of the article you want to export to EndNote 

− Click on the three dots below the button to print the article on the right 

− Select ‘Download RIS’ 

− When you open the downloaded reference, it will be added to EndNote 
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Google Scholar  

The option ‘import citations into EndNote’ is not automatically on. Go to settings (  in the upper left 

hand corner) and select ‘Show links to import citations into EndNote’  .  

 

 

After saving your preferences, every search result will display the option ‘Cite’ ( ). Click on 

‘EndNote’ and then on the downloaded file to import the reference into your EndNote library.  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

HeinOnline 

− Open your browser in Athena 

− Go to HeinOnline (directly from https://heinonline.org/HOL/Welcome or from lib.ugent.be) 

− Perform a search and click on the article you want to import into EndNote 

− In the text of the article, click on ‘Cite’ at the top left and at the bottom you can choose ‘Export RIS 

file’ 

− When you open the downloaded reference, it will be added to EndNote 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://heinonline.org/HOL/Welcome
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ProQuest 

− Open your browser in Athena  

− Go to ProQuest (directly from http://search.proquest.com or from lib.ugent.be) 

− Perform a search 

− Check the articles you want to export to EndNote and click . Select ‘RIS’ in the pop–up that 

appears. 

− Click ‘Continue’ in the next pop–up window. 

− When you open the downloaded reference, it will be added to EndNote. 

 

 

   

http://search.proquest.com/
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Ghent University catalog 

− Open your browser in Athena 

− Go to lib.ugent.be and perform your search 

− Click on the title you want to import, go to reference details (at the bottom of the page) and click 

‘Citing’ – ‘Download RIS file’.  

 

 

 

Biblio (Ghent University Academic Bibliography) 

− Open your browser in Athena 

− Go to biblio.ugent.be and perform your search 

− Add the references you want to export to your personal list via ‘add to list’. 

− Navigate to your personal list, click on ‘actions’ and select ‘Export list’. 

− Select ‘RIS (Reference Software)

 

 

3.2.1.4 Searching through EndNote  

It is possible to search various external databases directly through EndNote. However, keep in mind 

that searching from EndNote does not offer the same capabilities as the search functions in the 

databases themselves.  
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In the ‘groups’ tab on the left you will find some direct links to frequently used databases, such as the 

Ghent University library catalog (lib.ugent.be), or Web of Science. Clicking on 'More' will show you other 

options.  

 

When you select a database, EndNote connects to this database and a search screen appears at the 

top of the reference list panel. Here you can formulate your search query. 

 

Click 'Search': all sources that match your search will now appear in the list below the search bar. The 

references found are not immediately added to your library.  

 

To add references, select the sources you want to add in EndNote and click on the plus sign at the top 

right of the search results 
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Your selected references are then added to your library in EndNote. 

 

3.3 Using your library 

3.3.1 Groups 

Working with groups makes it easy to classify and find your references according to your own criteria. 

There are two possibilities: smart groups and custom groups. You can always place a reference in 

different groups. If you want to return to all references, select the field 'All references'.   

 

Smart Group 

A smart group allows you to find certain references via a search query and add them to the group. You 

can create a smart group via the 'Groups' - 'Create Smart Group' menu. 

Custom Group 

A custom group is a custom selection of references. You create this group by selecting a number of 

references and choosing 'Add References To' - 'Create Custom Group' from the 'Groups' menu. Later 

you can add new references to your custom group by dragging them from the reference list to the 

appropriate group. References removed from a group are not removed from your library. 

 

It is also possible to create a group set, a separate collection of groups. 

 

 

 



 
TITLE 

EndNote 21 manual (law and criminology programmes) 

DATE 

December 2023 

PAGE 

14/25 

3.3.2 Searching within your library 

The search bar allows you to search your library in full (entire library) or in part (groups). To do this, 

select the part of the database you wish to search in the Group panel and use the search bar in the 

reference list panel. Then build the search queries by linking the different search terms together using 

Boolean operators (and, or, not, ...) and click on 'Search'. 

 

 

 

 

3.3.3 Searching for full text  

By right-clicking on a reference in your library and selecting 'Find full text', it is possible to have EndNote 

search for full text versions of works whose reference you have entered in your EndNote library. The 

results are displayed under 'Find full text' in the Group tab. Of the articles found, a link or the pdf file will 

be added to the record in EndNote. It is recommended to check added links and if possible still save 

the pdf file, as links are not always stable. 

 

 

 

3.4 Print 

It is possible to print all or part of a database/library in the desired style. It is also possible to 'print' as a 

Word file or pdf file. 

 

Create print/pdf file  

− Determine the appropriate output style 

− Select the references to be printed 

− Select 'File' – ‘Print’ 

− To create a pdf file select pdf-creator as printer 
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Create a file that is editable with Word 

− Determine the appropriate output style 

− Select the references to be printed 

− Select 'File' – ‘Print’ 

− Select ‘Rich Text Format’ as the file type (extension .rtf)   
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4 ENDNOTE (21) AS A WRITING AID  

Be sure to open both Word and EndNote through Athena. 

 

4.1 Cite while you write  

4.1.1 Introduction 

The dynamic link between EndNote and Word allows you to invoke EndNote's references and 

(formatting) capabilities while writing, the ‘Cite While You Write’ principle. Moreover, if both EndNote 

and Word are open, you can easily switch between the two programs. 

 

When you insert references in Word, a bibliography is automatically created at the end of the text. This 

bibliography is formatted based on the selected Output Style. 

 

To use this functionality it is important that you open Word through Athena. In Word on Athena, the 

EndNote toolbar is always available. 

 

 

 

4.1.2 Adding a reference 

Before you add a reference, make sure the cursor is in the right place in the text. A reference always 

appears in the same place where it applies. It is important to know in advance whether a reference style 

works with footnotes (references at the bottom of the page, e.g. V&A), or with references within a text, 

e.g. APA. If the reference style uses footnotes, you must first click on 'References > 'Insert Footnote' in 

Word and only then use EndNote to insert a reference. The bibliography is automatically added at the 

end of the document.  

 

There are 2 ways to insert a reference.  

 

1. Via ‘Insert Citation’ – ‘Insert Selected Citations’ 

− Select the 'EndNote 21' tab in the toolbar at the top  

− In EndNote, select the desired reference  

− Put the cursor in the right place in Word  

− Click on ‘Insert Selected Citation(s)’  
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2. Via ‘Insert Citation’ – ‘Find and Insert Citation’  

− Select the 'EndNote 21' tab in the toolbar at the top  

− Put the cursor in the right place in Word  

− Click on ‘Insert Citation’  

− All references matching the search term will be displayed. Select the desired reference and click 

'Insert'. 

 

 

 

In either case, you can insert multiple references in a footnote or in the text itself. To do this, simply 

select the second reference and click ‘Insert Selected Citation’, or find the second reference using the 

second method. The different references are then separated by a semicolon and comma - depending 

on the output style.  

 

4.1.3 Output Style 

The references and bibliography are displayed in your chosen reference style. You can adjust this 

output style via the 'EndNote 21' > 'Style' tab. This way you don't have to spend hours manually entering 

and editing the footnotes and bibliography. 

 

If you want to publish in a journal, a specific output style is often required. This can usually be found 

under 'author instructions' on the journal's website. It may be a generic or journal-specific referencing 

style. For many of these journals a specific EndNote output style is available. You can select these 

reference styles when clicking on 'Style' > 'Select Another Style'. Note that journal names are often 
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abbreviated, so you cannot search by full terms. For example, European Review of Private Law 

becomes Euro Rev Private Law. 

 

Since V&A is a frequently requested reference style within the legal field in Flanders, this will be 

discussed in the next section. 

 

4.1.4 Editing and deleting references 

The bibliography is a field, linked to your database/library. It is best not to make changes in the Word 

document itself, since they are normally overwritten again the next time EndNote modifies the 

references. It is better to make corrections directly in EndNote. The adjustments will be implemented 

immediately. 

 

Edit reference  

Select the reference, and click on 'Edit Library Reference(s)'. This will lead you to the reference in 

EndNote where you can make the necessary adjustments. Remember to click 'Save' to save the 

adjustments. This changes will not immediately be reflected in Word. To do that, click ‘Update Citations 

and Bibliography’, which will apply the changes to citations and the bibliography. 

 

Delete reference 

Select the reference, click on ‘Edit and Manage Citation(s)’, and then select ‘Remove Citation’ under 

‘Edit Reference’ to the right of the appropriate reference. 

 

Adding specific pages, additional information, ... to a footnote or in-text citation 

Some reference styles support references to specific pages in a book/article/... Since entering a 

reference in Word with EndNote sometimes involves an entire publication, the specific pages must be 

entered later. This can be done by selecting the reference, selecting 'Edit and Manage Citation(s)’ and 

entering the specific pages under 'Pages'. If you wish to reference more specifically than the page (e.g. 

marginals), this can also be entered in the 'Pages' box after the pages. 

 

E. DE BUSSER, Data protection in EU and US criminal cooperation, Antwerp, Maklu, 2009, 474 p.  

then becomes: 

E. DE BUSSER, Data protection in EU and US criminal cooperation, Antwerp, Maklu, 2009, 120-122.  

 

It is also possible to add other things before or after the reference such as pages (in case the 'pages' 

field is not supported) or additional information such as '(unpublished)'. This can be entered in the 'prefix' 

or 'suffix' field, respectively. The prefixes and suffixes are displayed in exactly the same way as entered, 

including spaces. 

 

Editing footnotes in a Word document 

Sometimes a reference style will contain errors or the result is not fully satisfactory. These adjustments 

only happen at the very end, once the document is completely finished. At that point a copy(!) of your 

document should be saved, then in this copy go to the 'EndNote 21' tab. Click on 'Convert Citations and 

bibliography' – 'Convert to Plain Text'. The references are then no longer linked to the EndNote library 

and can be edited freely.  
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Editing in-text citations 

Some reference styles, such as APA (see below), do not use footnotes, but put a summary description 

of the work in the text. The full reference can be found in the bibliography. EndNote can easily switch 

between different views, e.g. from '(Vermeulen, 2020)' to 'Vermeulen (2020)', according to your 

preferences. This is done by right-clicking on reference, going to 'Edit Citation(s)' and changing the style 

to e.g. 'Author (Year)' or 'Exclude Author'.  

 

4.1.5 Preferences 

Via the ‘Preferences’ button you can set your preferences for working with EndNote.  

 

EndNote and Word are in constant communication with each other (=instant formatting). In some 

situations, such as large libraries, many references in a text or a slow computer, this can cause Word 

to work very slowly. In that case, it is wiser to turn off the instant formatting option. 

 

In Word, click on the EndNote 21 tab and select ‘Turn Instant Formatting Off’. It is now possible to edit 

your text or add new references, but they will not be put in the correct style until you issue the 'Update 

Citations and Bibliography' command yourself. 
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5 USING V&A AS REFERENCE STYLE IN ENDNOTE 

Within the legal field in Flanders, the rules established by the Committee Juridische Verwijzingen en 

Afkortingen (V&A for short) are ubiquitous. Unfortunately, no V&A output style is provided by EndNote, 

so Ghent University’s Faculty of Law and Criminology developed one themselves. If you use the Athena 

version of EndNote, you can select it under ‘Tools’ > 'Output Styles' > ' Open Style Manager'. Once it 

has been added, the V&A output style will appear in the list under ‘Output Styles’. The same goes for 

Word, where you will find it in the ‘Styles’ drop-down or can add it via ‘Select Another Style’.  

 

An important note: EndNote is a software package that has a broad target audience. However, the legal 

field has specific reference rules that are anything but uniform across borders. This makes it difficult to 

reference foreign legislation and case law. Added to this is the fact that EndNote is American software, 

so the fields to be inserted are not always adapted to the requirements for references to Belgian 

legislation and case law. The EndNote V&A output style will correctly refer to Belgian legislation and 

case law. In contrast, foreign legislation and case law will often have to be entered manually. Remember 

that consistency is important, even if your references do not fully conform to the desired style. If you 

write for the Anglo-Saxon jurisdiction and use Anglo-Saxon sources, you might want to consider using 

OSCOLA, the EndNote output style developed by the Faculty of Law of Oxford University. It is available 

in EndNote. More information about this output style can be found at https://www.law.ox.ac.uk/research-

subject-groups/publications/oscola-styles-endnote-latek-refworks-and-zotero. 

 

Below you will find what rules to observe when referencing with EndNote using the V&A style. Often 

these are V&A rules that must be applied and are merely repeated here, sometimes they are about the 

limitations of EndNote. 

 

! Footnotes must always be edited in Word or will be incomplete! Once the footnote is added in Word 

you still need to list the specific pages you are referring to by right-clicking on the reference, selecting 

'Edit citation' and entering the specific pages under 'Pages' (see 4.1.4 above). 

 

Books 

− If the book is published in different places, you only need to enter the first place of publication in 

your EndNote reference (=V&A rules).  

− If the place of publication is unknown, EndNote will not automatically choose 's.l.'. Therefore, you 

should include 's.l.' in the 'Place Published' field. In other words, EndNote only converts the data into 

the desired form, you still have to provide the content yourself.  

− If the year of publication is unknown, EndNote will not automatically list 's.d'. Therefore, you should 

enter 's.d.' in the 'Year' field. However, if the work is loose-leaf, you must - as V&A rules stipulate - 

include 'losbl.' in the 'Year' field 

− Because EndNote cannot work with 'if-then' formulas, if neither the place nor the year of publication 

are known, it will be displayed like this: 'AUTHOR, Title, s.l., s.d., number of p.' instead of 'AUTHOR, 

Title, s.l.n.d., number of p.' However, you can fix this by inserting s.l.n.d. in the 'Year' field, or adjust 

this later when you convert the reference to plain text (see below).  

− The problem with entering 's.l' or 's.d' in the place and year of publication fields, respectively, ensures 

that this will also appear if you change the reference style, e.g. to APA. So, in the few cases where 

no location or year are mentioned, you can choose to leave these fields blank and manually edit the 

footnote/bibliography at a later point. 

− If a book has multiple volumes and you are referring to a specific volume, list the volume in Roman 

numerals in the ‘Volume’ field (=V&A rules).  

− In a footnote, the total number of pages of the book will not be listed, since usually specific 

passages/pages are referred to. Those pages are inserted as described above. If you still want the 

https://www.law.ox.ac.uk/research-subject-groups/publications/oscola-styles-endnote-latek-refworks-and-zotero
https://www.law.ox.ac.uk/research-subject-groups/publications/oscola-styles-endnote-latek-refworks-and-zotero
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number of pages listed, you can use the same technique but list the number of pages in ‘suffix’ 

instead of ‘pages’. 

 

Webpage 

− If you want to mention the date the website was accessed, you have to enter both ‘access date’ 

(day, month) as well as ‘access year’. 

 

Journals 

− Journal names are automatically abbreviated if they were included in the appendix of the booklet 

Juridische Verwijzingen & Afkortingen (edition September 2022) or on rechtsaf.be. To do this, you 

need to do the following: in EndNote, go to 'Library' > 'Define Term Lists'. There you select ‘Journals’ 

- 'Import list' and open the 'Terms List' folder. There you select ‘Lijst afkortingen Belgische Law 

Tijdschriften (V&A).txt' and click 'Open'. For legislation or case law, the sources cannot yet be 

abbreviated automatically and you have to enter the abbreviated source yourself in the desired field 

(e.g. 'source'). 

− If a journal has continuous page numbering (i.e. does not start at 1 each issue) you do not have to 

include the issue number according to the V&A rules. Therefore, in that case, do not enter an issue 

number (‘Issue’), or EndNote will still list it in the footnote. 

− Don't forget to enter the first page of the article in the 'Start Page' field if you later want to refer to a 

specific passage in the article.  

− If the article is a note (note to case law), and this note has a title, state this in the 'Type of Article' 

field, e.g. Noot onder Cass. 21 juni 2002. 

− If the article is a note, but this note does not have a title, it is referred to as a standard article, and 

enter ‘noot onder …’ in the 'Title' field (=V&A rules).  

− If a journal covers two years (e.g. Rechtskundig Weekblad), for the second year, only enter the last 

two digits in the 'Year' field, e.g. 2004-05 instead of 2004-2005 (=V&A rules). 

 

Contribution in an edited book 

− A contribution in an edited book (several authors each write a section of a book that is edited by one 

or more editors) is entered as 'Book Section'.  

 

Edited book 

− For references to an edited volume you use ‘Edited Book’.  

 

Newspaper article 

− Put the year of publication in the ‘Year’ field. You enter the date in the ‘Issue Date’ field in the ‘day 

month’ form (e.g. ‘3 augustus’ for ‘Issue Date’ and ‘2011’ for ‘Year’). 

 

Serials 

− For references to serials you use ‘Serial’. 
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PhDs, dissertations, master’s theses, etc.  

− For references to doctorates, dissertations and master's theses, choose the 'Thesis' category. The 

type of work is listed in the 'Thesis type' field, e.g. doctoral thesis, master's thesis, etc. However, if 

these works are published, you choose ‘Book’.  

− Remember to fill in the field ‘Academic Department’ (e.g. Law and Criminology) and ‘University’. 

 

Reports, working papers, policy documents, etc.  

− For references to reports, select ‘Report’ 

− The year is entered in the 'Year' field, the rest of the date is put in the 'Date' field. The date can only 

be displayed correctly if the month is written in full or if no dots are put between the day and the 

month. If the month is entered as a number with a dot between the day and the month, the final 

result will show a space between the month and the year (which you can always correct manually 

afterwards, of course). So preferably '2 juni' or '02 06', but not '02.06'. 

− If the report has a number, this can be mentioned under 'Document number'. 

 

Legislation 

− For references to legislation, select ‘Statute’ 

− You can choose to insert the article number in EndNote, but then the EndNote reference can only 

be used for one article. It is recommended to insert the article number or paragraph number once 

the reference is inserted in Word. You do this by right-clicking on the reference > 'edit citation' > 

'more' > 'Prefix' e.g. 'art. 2§2'. 

− Anything that should come after the page of the citation should be entered manually via 'Edit citation' 

> ... > 'Suffix', e.g. note.  

− The publication must always be entered in abbreviated form (e.g. BS instead of Belgisch Staatsblad) 

in the 'Source' field. 

− The abbreviation of the law or code must be entered in the 'Short Title' field. The V&A output style 

will then use the short title, but other reference styles may prefer the official (longer) name. (E.g. 

Privacywet in 'short title' but ‘Wet van 8 december 1992 voor de bescherming van de persoonlijke 

levenssfeer ten opzichte van de verwerking van persoonsgegevens’ in 'Name of Act'). 

− Sometimes it is necessary to indicate the edition of the Staatsblad, e.g. when there are several 

editions of the same date. The edition is indicated in the 'Volume' field. 

− The date of publication in the Staatsblad or another source is entered in the 'Date Enacted' field. 

− If there is a statute number, it can be entered in the 'Statute number' field. 

 

Case law 

− For case law, select ‘Case’.  

− Enter the docket number in the ‘Docket Number’ field. If there is more than one docket number, all 

docket numbers are entered separated by a comma and 'en' is entered between the last two 

numbers. Abbreviations should also be listed (e.g. AR, nr.,...)  

− The source is entered in the 'Reporter' field.  

− Journal names are automatically abbreviated. For legislation or case law, the sources cannot yet be 

abbreviated automatically. The court must be entered abbreviated in the 'Court' field (e.g. HvB, 

Cas.). The source must be written in full in the 'Reporter' field and abbreviated in the 'Reporter 

Abbreviation' field.  

− In case the names of parties are relevant, they are mentioned in the 'Title' field. Put a slash between 

names of different parties. 

− The year of the journal/source should be given in the 'Volume' field, e.g. RW 2009-10 or BS 4 mei, 

2008. 

− In the 'Year decided' field the year is given, in the 'Date decided' field the day and month.  



 
TITLE 

EndNote 21 manual (law and criminology programmes) 

DATE 

December 2023 

PAGE 

23/25 

− Enter additional information manually once the reference is added in Word. Right-click on the 

reference > 'edit citation' > 'more' > 'suffix', e.g. 'noot S.VAN OVERBEKE' or '[reference to conclusion 

only]. 

 

Footnotes 

− If a footnote refers to a specific passus, as mentioned above, you must click on the specific reference 

in Word and go to 'Edit citation' > 'more' and list the specific pages there. 

 

Bibliography 

− It is often expected that the bibliography is divided into legislation, case law and doctrine. Select the 

desired references in EndNote (easy if you have created a 'Group' with the references used during 

a particular study) and select 'Subject Bibliography' from the 'Tools' menu in EndNote. Select 

'Reference Type' and click on 'OK'. Select the 'Reference Types' that fall under Legislation, Case 

Law or Doctrine respectively (ctrl to select multiple reference types) and press OK. You are then 

given the option to print, change the layout, create a pdf (via CutePDF or PDFcreator) or you can 

copy and paste the text into a Word document. 

 

Extra 

− The V&A rules do not contain rules for every type of source. 

− If you refer to an online source of an article or book, state it in the 'URL' field. The V&A rules require 

that if you mention an online source, you separate it from the preceding information by the word 'en'. 

However, when using EndNote, a comma will be placed.   
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6 USING APA (7TH) AS A CITATION STYLE IN ENDNOTE 

Within the criminology programme, APA is usually preferred as a citation style. This citation style, 

established by the American Psychological Association, is currently in its 7th version. 

 

Some general characteristics of the APA referencing style :  

− references to the text itself with the name of the first author(s) (name–date system) 

− book title or journal name in italics 

− bibliography alphabetical by author 

− edited volumes use the name of the editor, unless referring to a specific contribution 

 

The specific rules related to this reference style are well documented and further explained in the 

Encyclopedia of Criminological Sciences course.  

 

In the criminology programme at UGent, the guidelines regarding the use of the APA reference style, 

possibly in combination with the V&A reference style, are very clear:  

Students should use one – or if required, a combination – of the two following reference styles: (1) the 

American Psychological Association (APA) style or (2) the Juridische Verwijzingen en Afkortingen 

(V&A) style. 

 

For a paper with only social science sources, the APA style will be used. A paper with primarily legal 

sources will use the V&A style. 

 

If a paper contains both social science and legal sources, a combined system is adopted, using V&A 

style (with footnotes) for legal sources and APA style (in–text references and bibliography) for social 

science sources. 

 

Automatically combining both styles in one document via EndNote is not possible. In this case, for the 

sources referenced via the APA style, it is recommended to use the EndNote plugin in Word. For the 

sources referenced using the V&A style, you can use the footnote function (References > Insert 

footnote) in Word. You then add those sources manually.    
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USEFUL LINKS 

Helpdesk DICT: https://helpdesk.ugent.be/software/en/endnote.php 

Here you will find more information about the programs, sample databases and instructions for 

installing the programs. 

 

Website EndNote: http://www.EndNote.com 

 

In case of questions or problems, please contact: libservice@ugent.be of lawlib@ugent.be 
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